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Start Here

Welcome to ACT! by Sage 2007 (9.0). The ACT! 2007 software is 
designed for individuals and small workgroups of up to 10 users. The 
ACT! 2007 software uses Microsoft® SQL Server™ 2005 Express 
Edition.

About the Start Here
Read this guide before installing the ACT! 2007 software. This guide 
contains important information for installation, upgrades, and 
conversion, and is organized as shown in the following table.
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CD Contents
Preparing to Install

CD Contents
The ACT! 2007 installation CD includes the following items.

• Install ACT! includes:

- ACT! 2007 software and supporting files.

- Microsoft .NET 2.0 Framework - Platform used to build and run the 
ACT! 2007 software. This component is required and is installed with 
the software, unless it is already on your computer. 

- Microsoft SQL Server 2005 Express Edition - Software used to create 
and manage the ACT! database. This component is required and is 
installed with the software. With a SQL Server Express Edition 
installation, you can have up to 10 active users per database and a 
maximum of 4 gigabytes (GB) of data for each database. 

Note:  The 4 GB limit does not include supplemental files, such as 
layouts and templates, attachments, and e-mail. ACT! E-mail is a 
separate database with its own 2 GB limitation.

• Software for Handhelds includes:

- ACT! Link for Palm OS® - Application used to send and receive ACT! 
2007 data to/from a Palm OS handheld device. See the ACT! Handheld 
Links Start Here for installation instructions.

- ACT! Link for Pocket PC - Application used to send and receive ACT! 
2007 data to/from a Pocket PC handheld device. See the ACT! Handheld 
Links Start Here for installation instructions.

• Product Documentation includes:

- ACT! Start Here guide

- ACT! User’s Guide

- ACT! Handheld Links Start Here

- Handhelds Installation Tour
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Before You Install
• Related Software includes:

- Adobe® Reader® 6 - Optional application that lets you view 
documentation and output ACT! reports as PDF documents.

- Microsoft Internet Explorer® 6 - Used for the software’s integrated 
Internet Services.

• Online Resources includes links to ACT! add-on programs, the support 
site, and more.

Before You Install
This section explains what you need to do before you install the ACT! 2007 
software, whether for the first time (New User) or as a version upgrade 
(Upgrade User). 

New User

✓ Be sure to: If you do not, this will happen:

Sign on as a Windows administrator. Installation and activation 
will fail.

Make sure your system meets the 
hardware and software requirements listed 
on the product package or Web site.

Installation will fail.

Disable antivirus and firewall software. 
(You can enable it after installation is 
complete.)

Installation may fail.

Close all open applications. Installation may fail.

If you want to install to a destination other 
than the default (C:\Program 
Files\ACT\ACT for Windows), verify that 
folder-sharing rights are enabled and the 
directories exist.
Note: You cannot install the software to a 
network drive or run it from CD.

Installation will fail.
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About Upgrading and Downgrading the Database
Upgrade User

Next Step
New Users Install. See "Installing the ACT! 2007 Software" on page 13.

Upgrade Users from ACT! 3.x - 6.x Applications Read "What ACT! 3.x - 6.x 
Users Should Know" on page 5. 

Upgrade Users from ACT! 2005 and ACT! 2006 Applications Read "What 
ACT! 2005 and ACT! 2006 Users Should Know" on page 8.

Users Moving from ACT! by Sage Premium for Workgroups 2007 (9.0) 
Applications to ACT! 2007 Applications Read "What ACT! Premium 2007 
Users Should Know" on page 11.

About Upgrading and Downgrading the Database
This section explains how to prepare the database before upgrading to ACT! 
2007 from the following software:

• ACT! 3.x - 6.x

• ACT! 2005 (7.x) or ACT! 2006 (8.x)

It also gives considerations for downgrading from the ACT! Premium for 
Workgroups 2007 (9.0) software to the ACT! 2007 software.

✓ Be sure to: If you do not, this will happen:

Complete the items on the New User list. Installation will fail.

If you will synchronize databases, verify 
that they all use the same version and tier 
of the ACT! software.

Databases will not 
synchronize after installation.

If you used Palm OS or Pocket PC 
handheld devices with the ACT! 6.x, 
ACT! 2005, or ACT! 2006 software, update 
the handheld links.
Note: After installing ACT! 9.0, install the 9.0 
version of the handheld links software. For 
install instructions, see the ACT! Handheld 
Links Start Here (available on CD 1). 

You will lose any data on the 
handheld device that has 
not been synchronized with 
ACT!.
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About Upgrading and Downgrading the Database
What ACT! 3.x - 6.x Users Should Know
The underlying architecture for ACT! 2007 is different than that for ACT! 3.x 
- 6.x, so you must prepare the ACT! 3.x - 6.x database for conversion. Note the 
following:

• You must be an Administrator user in the original database to convert it.

• Converting a database increases the database size. 

• Conversion places the new database locally.

• Conversion copies the original database and then converts it. The original 
ACT! 3.x - 6.x database is retained.

• Once you convert an ACT! 3.x - 6.x database to an ACT! 2007 database, you 
cannot open the converted database in previous versions of the ACT! 
software, and you cannot save data to the previous versions.

• An ACT! 2007 database has special types of fields for phone numbers, 
addresses, and secondary contacts. If you added custom fields of these 
types in your ACT! 3.x - 6.x database, use the Custom Conversion option. 
This option lets you map your custom fields to the ACT! 2007 database 
fields. No data is lost; it all converts. See "Types of Conversion" on page 16 
for details. 

• ACT! 3.x - 6.x databases store date and time fields as literal values (for 
example, an appointment scheduled at 1:30 P.M. in Arizona displays to all 
users as 1:30 P.M., regardless of a user’s time zone). ACT! 2007 databases 
store date and time fields as Greenwich Mean Time (GMT), so the data 
displays according to a user’s time zone. If you have multiple databases, 
set all the databases to a "home" time zone before you upgrade. You can 
reset the time zone for individual databases after conversion.

• Fields that are set to "Not Allow Editing" in an ACT! 6.x database convert 
to Read Only fields in an ACT! 2007 database.

• If you synchronize remote databases in your ACT! 3.x - 6.x software, 
synchronize all data into one database before converting. After you install 
the ACT! 2007 software, convert that database, and then create new remote 
databases to distribute to your remote locations and users. The Help 
describes how to create and distribute new remote databases.
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About Upgrading and Downgrading the Database
How Data Converts

Converts?

Data Yes No Comments

Activities X

Activity Series X

Contact records X

Database tables and fields X

E-mail addresses X If you stored multiple e-mail 
addresses for a contact, the 
software converts those addresses 
to new fields, but you must add the 
new fields to see them on layouts. 
The fields are visible in the Define 
Fields list.

Group members X These convert as static members. If 
a group’s membership was based 
on a rule, that criteria does not 
convert.

Group records X

Group rules X

Histories X

Macros X

Menu/toolbar customizations X

Notes X

Opportunities X Opportunities without a sales stage 
or probability convert as a New 
Opportunity stage with 100% 
probability.

Opportunity processes X These convert as a Previous ACT! 
Sales Process.

Microsoft Outlook® activities 
updated to ACT! calendars

X
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About Upgrading and Downgrading the Database
Preparing the 3.x - 6.x Database for Conversion
To prepare the database for conversion, complete the following tasks:

Next Step
Install. See "Installing the ACT! 2007 Software" on page 13.

Private subgroups X A private subgroup of a public 
group converts to a public group.
A private subgroup with a different 
Record Manager than its parent 
group converts to a private parent 
group.

Queries X

Saved reports (.rpt files) X

Some preferences X

Synchronization settings X

User records X

✓ Task

If you use passwords, record the usernames and passwords for use after 
conversion.

Delete obsolete data in the existing database. See "About database 
maintenance" in the Help.

Compress and re-index the database. See "About database 
maintenance" in the Help.

Run the ACT!Diag tool. The Integrity Checker and all items should be 
checked green.

Open the database again to re-index it. See "About database 
maintenance" in the Help.

Back up the ACT! database.

Converts?

Data Yes No Comments
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About Upgrading and Downgrading the Database
What ACT! 2005 and ACT! 2006 Users Should Know
You can upgrade from the ACT! 2005 or 2006 software to the ACT! 2007 
software. 

Note:  If you are currently using the ACT! Premium for Workgroups 
2005 or 2006 software and will install the ACT! 2007 software (not the 
ACT! Premium for Workgroups 2007 software), you must prepare the 
database before upgrading it. See "Preparing an ACT! Premium for 
Workgroups 2005 or 2006 Database for Use with the ACT! 2007 Software." 

When you upgrade from the ACT! 2005 or 2006 software to the ACT! 2007 
software, be aware of the following:

• You cannot have the following versions of the ACT! software on the same 
machine as the ACT! 2007 software: 

- ACT! 2005 or 2006

- ACT! Premium for Workgroups 2005 or 2006

- ACT! Premium for Web 2005 or 2006

When you install the ACT! 2007 software, the install process uninstalls any 
ACT! 2005 or 2006 software.

• To upgrade the main database, you must be an Administrator or Manager 
user, and must upgrade it on the computer it resides on. You cannot 
browse to a database on another computer to upgrade it.

• To upgrade a remote synchronized database, you must be an 
Administrator or Manager user (or a Standard user, if there is no active 
Administrator or Manager), and you must belong to the remote database.

Caution:  Preparing the ACT! Premium 2005 or 2006 database breaks 
the synchronization relationship, so first synchronize all remote 
databases to the main database. After you install the ACT! software 
and upgrade the database, you can create new remote databases.

• An upgrade uses the original database, not a copy; however, the upgrade 
process lets Administrator and Manager users (but not Standard users) 
create a backup copy of the database before upgrading it.

• Once you have upgraded a database, you cannot open it in previous ACT! 
versions, and you cannot save data to the previous versions.
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About Upgrading and Downgrading the Database
• If the installer detects an ACT! 2005 or 2006 e-mail database, it will ask if 
you want to save a copy of the database before upgrading it. 

Note:  Once you upgrade the e-mail database, it will not work with 
the ACT! 2005 or 2006 software. Therefore, you should save a copy of 
the e-mail database, in case you choose to move back to the ACT! 2005 
or 2006 software. The copy stays in the original location. The installer 
puts the upgraded e-mail database in C:\Documents and Settings\ 
All Users\Shared Documents\ACT\ACT for Windows\Email. 

• You do not need to upgrade ACT! 2005 or 2006 database supplemental 
files, such as layouts, reports, and templates. They open in the ACT! 2007 
software. 

How Data Upgrades

Upgrades?

Data Yes No Comments

Activities X

Activity series X

Column customizations X

Company records X

Contact records X

Database tables and fields X

Database user preferences X

Global ACT! user preferences X When users open the software for 
the first time, the software 
automatically copies and 
upgrades the ACT! 2005 or 2006 
user preferences. If the software 
cannot locate those preferences, 
it uses the default preferences.

Group records X

Histories X

Menu/toolbar customizations X

Notes X

ON setting for Accept 
Incoming Syncs

X The port number is retained.
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About Upgrading and Downgrading the Database
Preparing an ACT! Premium for Workgroups 2005 or 2006 
Database for Use with the ACT! 2007 Software
You must prepare an ACT! Premium for Workgroups 2005 or 2006 database 
to work with the ACT! 2007 software. You should back up the database before 
preparing the database

WARNING:  These steps only apply if you currently use the ACT! 
Premium for Workgroups 2005 or 2006 software and will install the ACT! 
2007 software.

To prepare the ACT! Premium for Workgroups 2005 or 2006 database
1. Synchronize all remote databases into the main database.

2. In the ACT! Premium for Workgroups 2005 or 2006 software, from the File 
menu, click Save Copy As.

The Save Copy As dialog box appears.

3. In the Database Name field, type the name of the new database. 

4. In the Database Location field, type the location for the database or click 
Browse to locate a folder.

5. To share the database with other users, select the Share this database with 
other users check box.

6. In the Options box, select Create a copy of the database. 

7. From the Database Version list, select ACT! 2005 or ACT! 2006, and then 
click OK.

The Copying status message appears until the process is complete.

Opportunities X

Outlook activities updated to 
ACT! calendars

X If you run Update Activities after 
upgrading the database, no 
duplicates are created.

Queries X

Synchronization settings X This does not include 
synchronization services. (See the 
Knowledge Base articles for 
information on upgrading the 
synchronization services.)

User records X

Upgrades?

Data Yes No Comments
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About Upgrading and Downgrading the Database
Next Step
Install. See "Installing the ACT! 2007 Software" on page 13. 

What ACT! Premium 2007 Users Should Know
You can downgrade a database to an ACT! 2007 database. You would do this 
if you bought the ACT! Premium for Workgroups 2007 software and then 
your business situation changed, and you do not need the features of the 
ACT! Premium for Workgroups 2007 software.

• Manager or Administrator users can downgrade an ACT! Premium for 
Workgroups 2007 database to an ACT! 2007 database. You must prepare n 
ACT! Premium for Workgroups 2007 database to work in the lower-tier 
ACT! 2007 version.

• You must downgrade the database version before you uninstall the ACT! 
Premium for Workgroups 2007 software.

• Downgrading a database breaks the synchronization relationship for main 
and remote databases. To avoid data loss, synchronize all remote 
databases to the main database, downgrade the main database to the ACT! 
2007 database, uninstall the ACT! Premium for Workgroups 2007 
software, and install the ACT! 2007 software. Then, you can create new 
remote databases in the ACT! 2007 format.

• When you downgrade to an ACT! 2007 database, fields that had an access 
level of No Access, either by default or for any users or teams, convert to 
Read Only access.

Downgrading the ACT! Premium 2007 Database

Caution:  If you have remote databases, synchronize them to the main 
database, and then downgrade the main database.

To downgrade the ACT! Premium for Workgroups 2007 database
1. In the ACT! Premium for Workgroups 2007 software, from the File menu, 

click Save Copy As.

The Save Copy As dialog box appears.

2. In the Database Name field, type the name of the new database. 

3. In the Database Location field, type the location for the database or click 
Browse to locate a folder.

4. To share the database with other users, select the Share this database with 
other users check box.

5. In the Options box, select Create a copy of the database.
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About Upgrading and Downgrading the Database
6. From the Database Version list, select ACT! 2007, and then click OK.

The Copying status message appears until the process is complete.

7. When the Save As was successful message appears, click OK.

Next Step
Uninstall the ACT! Premium for Workgroups 2007 software. See "Uninstalling 
the ACT! Premium for Workgroups 2007 Software." You must do this before you 
can install the ACT! 2007 software.

Uninstalling the ACT! Premium for Workgroups 2007 Software
After you have downgraded the database to an ACT! 2007 database, you can 
uninstall the ACT! Premium for Workgroups 2007 software.

Note:  Remote users who will use the ACT! 2007 database must 
uninstall the ACT! Premium for Workgroups 2007 software.

To uninstall the ACT! Premium 2007 software
1. Close any open applications.

2. From the Windows Control Panel, click Add or Remove Programs.

3. Select ACT! Premium 2007, and then click Change/Remove.

4. On the Welcome page, select Remove, and then click Next.

5. Click OK to confirm the uninstall.

6. When complete, click Finish.

Next Step
Install. See "Installing the ACT! 2007 Software." 
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Installing the ACT! 2007 Software
Installing, Registering, and Activating

Installing the ACT! 2007 Software
This section explains how to install the ACT! 2007 software.

Note:  The Install Wizard guides you through the process. Click Back 
to change the information on previous pages before the install starts, or 
click Cancel at any time to cancel the installation.

To install the ACT! 2007 software
1. Insert the ACT! 2007 CD into the CD drive. The program starts 

automatically.

Note:  If the installation program does not start automatically, do the 
following: From the Windows Start menu, click Run. Type D:SETUP, 
and then click OK. (Substitute the appropriate drive letter for your 
CD drive.) 

From the CD browser page, you can install the software and other listed 
items.

2. Click Install ACT!.

The Install Wizard checks for necessary components. 

If you do not have the required version of MDAC or the Windows Installer 
on your computer, the Install Wizard installs them. Then, the Install 
Wizard asks if you want to reboot your computer. Click Yes. (Microsoft 
requires the reboot. If you click No, the installation will fail.)

After rebooting, log on to your computer if necessary. The Install Wizard 
resumes automatically. (If it does not, repeat steps 1 and 2 of this 
procedure.)

If you do not have Microsoft .NET 2.0 Framework on your computer, the 
Install Wizard next asks if you want to install it. Click Yes to open the .NET 
installer. (If you click No, the installation stops.) After installing the .NET 
framework, the Install Wizard starts installing the ACT! 2007 software.

3. Follow the instructions on the wizard pages to choose a region and accept 
the license agreement.

Note:  If you do not accept the license agreement, the installation stops.
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Installing the ACT! 2007 Software
Click Next to advance through the wizard. If message prompts appear, 
read and follow the instructions.

4. Choose the destination locations (or keep the default locations) for the 
ACT! and SQL Server Express software installation. (The destination 
location is the location, such as a drive, folder, or directory, for the 
software and supporting files.)

Caution:  If you add functionality with plug-ins (third-party software 
applications that work with ACT!), they may stop working if you install 
ACT! to a non-default location. You may need to reinstall them.

Note:  You can select a non-default installation location for SQL Server 
Express Edition. However, Microsoft requires that some key system 
files are installed in the default location inside the local Program Files 
directory.

5. On the Specify who can use ACT! page, select an option. By default, 
Anyone who uses this computer is selected (and recommended). Click 
Next to advance.

Note:  If you select the Only me option, only the current Windows user 
can use the demonstration database files, folder structures, and the ACT! 
.pad file. (The .pad file is a pointer to the ACT! database.)

6. Follow the instructions on the remaining wizard pages to select a program 
folder, place icons, and copy files. Click Next to advance.

7. On the ACT! Setup Complete page, read the information, and then select 
the options to Launch ACT! and View README file. Click Finish.

8. If you selected to launch (start) the software, when it opens, the ACT! 
Update message appears. Click Yes to check for updates; click No to 
continue with registration.

Note:  You must register and activate the software to use it. If you do 
not register and activate it, the software will stop working in 30 days. 

Next Step
Register and activate the software as described in the next section.
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Registering and Activating the Software
Registering and Activating the Software
This section explains how to register and activate the software. This is 
required to use the product. Registration ensures you of timely program 
updates, upgrade offers, and customer support options. After you register, 
you activate the software on each computer that the software is installed on.

The ACT! Registration and Activation Wizard guides you through the 
process. You must have the serial number (printed on the back of the CD 
sleeve or provided with your downloaded product). You can register by 
Internet or telephone.

To register and activate the software
When you first start the software, the Registration and Activation Wizard 
appears.

1. In the Registration Options box, select an option (Internet or Phone), and 
then click Next.

Note:  If you do not register and activate the product when you first 
start it, you can do it later. From the Help menu, click Register ACT! to 
open the Registration and Activation Wizard.

2. Follow the instructions on each page. Click Next to advance.

Tip:  If you are upgrading from the ACT! 2005 or 2006 software, the 
ACT! 2005 or 2006 serial number remains in the Windows Registry on 
the computer, in case you need to go back to that version. 

3. When finished, click Activate.

If you receive an error message, follow the instructions in the message. 

Next Step
New Users You are done! You can:

• Use the Getting Started Wizard to help you set up your word processor, 
e-mail system, and database.

• Start working with the ACT! software. See "Getting started" in the Help. 

• View the feature tours to learn more about ACT! features. In the ACT! 
software, point to Help, point to Feature Tours, and then click a tour.

• Create a remote database, if you plan to synchronize with remote 
databases. See "Creating remote databases" in the Help.
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Converting an ACT! 3.x - 6.x Database
• If you administer the ACT! software for a workgroup that will share the 
database, make sure that all users install the ACT! 2007 software. Then, 
you can distribute a shortcut to the .pad file for the ACT! database.

Upgrade Users from ACT! 3.x - 6.x Applications Convert the database. See 
"Converting an ACT! 3.x - 6.x Database" on page 16.

Upgrade Users from ACT! 2005 or 2006 Applications Upgrade the 
database. See "Upgrading an ACT! 2005 (7.x) or 2006 (8.x) Database" on page 19.

Downgrade Users from ACT! Premium for Workgroups 2007 Applications to 
ACT! 2007 Applications You are done! You can open the ACT! 2007 software 
and the database. Other items to consider:

• All users who share the database must install the ACT! 2007 software. You 
can distribute a shortcut to the .pad file for the database to the users. 

• If you plan to synchronize remote databases, see "Creating remote 
databases" in the Help.

Upgrading and Converting Databases

Converting an ACT! 3.x - 6.x Database
This section explains the differences between Standard and Custom 
conversion and gives the steps for converting an ACT! 3.x - 6.x database.

Types of Conversion 
Conversion maps data from the fields of one database to data in the fields of 
another database. The two conversion types for ACT! 3.x - 6.x databases are 
Standard and Custom. All data fields convert with either option; no data is lost.

Standard conversion (Recommended) Uses the default mapping of fields. 
Use Standard conversion if you have not added custom address, phone, or 
secondary contact fields to your ACT! 3.x - 6.x database.

Custom conversion Lets you change field mapping before converting the 
database. Use Custom conversion if you have added custom fields for addresses, 
phone numbers, or secondary contacts to your ACT! 3.x - 6.x database. During 
conversion, a secondary contact record is created if any fields on the Secondary 
Contacts tab contain data. (For example, if a Contact field on the Secondary 
Contacts tab has data, but no other fields on the tab do, the conversion produces 
a secondary contact with only the contact name filled in.) 
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Converting an ACT! 3.x - 6.x Database
When database conversion is complete, you can choose to convert 
supplemental files. The option to convert them later is selected by default. For 
more information on converting supplemental files, see "Converting ACT! 3.x 
-6.x supplemental files" in the Help.

Converting an ACT! 3.x - 6.x Database
Follow the instructions for a Standard or Custom conversion. For help on any 
page of the Database Conversion Wizard, press F1.

To perform a Standard conversion of an ACT! 3.x - 6.x database
1. Open the ACT! 2007 software, and then click Open Database on the 

toolbar. 

2. In the Open dialog box, in the Files of type field, select ACT! 3 - 6 
Database (*DBF) from the list, and then locate the database file. 

3. Select the database, and then click Open.

4. If a verification message appears, click OK.

5. In the Database Conversion Wizard, follow the instructions on the wizard 
pages. Click Next to advance through the wizard.

6. If prompted, type the ACT! 3.x - 6.x database user name and password, and 
then click OK.

7. On the Conversion Type page, select Standard Conversion, and then 
click Next.

8. If the ACT! 3.x - 6.x version had more than 10 active users, on the Select 
Active Users page, select 9 users besides yourself who can be active in the 
ACT! 2007 database. Other users convert as inactive. Click Next to 
continue.

9. On the Specify Target Database page, complete the fields. If more than 
one user has log-on privileges to the database, select the Share Target 
Database option.

10.At the message prompt, click OK to start the conversion. Conversion may 
take several minutes. 

11. On the Completing the Conversion Wizard page, click Details to see the 
details about converted items, and then click Finish to close the wizard. 

The database opens, and you can view the data.
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Converting an ACT! 3.x - 6.x Database
To perform a Custom conversion of an ACT! 3.x - 6.x database
1. Follow steps 1 through 6 in "To perform a Standard conversion of an ACT! 

3.x - 6.x database."

2. On the Conversion Type page, select Custom Conversion, and then click 
Next.

3. On the first Convert Contact Addresses page, review the default field 
mapping for the Main address fields, and then do the following:

a. Accept the default mapping or make changes. 

b. When finished, click Next.

4. On the next Convert Contact Addresses page, review the default field 
mapping for the Home address fields, and then do the following:

a. Accept the default mapping or make changes.

b. If you have custom contact address fields in your ACT! 3.x - 6.x 
database, select I have more <Contact Addresses> to convert. 

c. When finished, click Next.

d. If you selected to convert additional fields in Step 4b, in the dialog box, 
type the name of the custom field, such as Vacation Home, and then 
click OK.

The custom field is added to the database. 

e. Map the ACT! 3.x - 6.x field from Step 4d to the new field, and then click 
Next.

5. For the remaining Custom field conversion pages, follow Steps 4a through 
4e again to convert group addresses, phone/fax numbers, and secondary 
contacts, if applicable. 

6. Follow the instructions on the remaining wizard pages. Click Next to advance.

Note:  If the database you are converting has more than one user with 
log-on privileges, select the Share Target Database option on the 
Specify Target Database page.

7. At the message prompt, click OK to start the conversion. Conversion may 
take several minutes.

8. On the Completing the Conversion Wizard page, click Details to see the 
details about converted items. Click Finish to close the wizard.
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Upgrading an ACT! 2005 (7.x) or 2006 (8.x) Database
Next Step
You are done! The database is ready to use. Some other items to consider:

• If you need to add to or change field mapping, you can use the Replace 
Field and Swap Field commands from the Edit menu to make corrections. 
However, you cannot replace and swap secondary contact fields.

• If you synchronize with remote databases, you must create new remote 
databases. For more information, see "Creating Remote Databases" in the 
Help.

• All users who share the database must install the ACT! 2007 software. You 
can then distribute a shortcut to the .pad file for the converted database.

• You can convert supplemental files during database conversion or later 
using the Tools menu. Supplemental files include report templates, e-mail 
templates, Microsoft Word and ACT! Word Processor templates, layouts, 
labels, and envelopes. For more information, see "Converting ACT! 3.x - 
6.x supplemental files" in the Help.

Upgrading an ACT! 2005 (7.x) 
or 2006 (8.x) Database
You upgrade an ACT! 2005 or 2006 database by opening it in the ACT! 2007 
software. This section gives those steps.

To upgrade an ACT! 2005 (7.x) or 2006 (8.x) database
1. Open the ACT! 2007 software.

2. From the toolbar, click Open Database.

3. In the Open dialog box, locate the folder that contains the database, and 
then from the Files of type list, select ACT! Database (*.PAD) or ACT! 
Database (*.ADF).

4. Select the database, and then click Open.

5. At the update prompt, click Yes.

6. At the backup prompt message, click Yes, and then complete the fields on 
the Back Up Database dialog box. Click No to skip the backup.

Note:  Only Administrator and Manager users can back up a database. We 
strongly recommend that you back up your database before upgrading it.

7. If a verification message appears, click OK.

8. If prompted, type your user name and password for the database, and 
then click OK.
Start Here 19
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9. At the update prompt, click OK. If you click Cancel, the update process 
stops.

10.At the update process complete message, click OK.

WARNING:  If the database you are converting was previously converted 
from an ACT! 6.x database, verify that the Allow history editing 
preference in the General tab has not changed. To do this, open the ACT! 
2007 software. From the Tools menu, click Preferences. The General tab 
opens by default. Under General Preferences, verify the setting.

Next Step
If you do not synchronize, you are done! The database is ready to use. Make 
sure that all users who share the database install the ACT! 2007 software. 
Then, you can distribute a shortcut to the .pad file for the database.

If you used the ACT! Network Synchronization Service or ACT! Internet 
Synchronization Service with the ACT! 2005 or ACT! 2006 software, you must 
upgrade the synchronization service software. Refer to the Knowledge Base 
articles to do this.
20 ACT! 2007
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